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Introduction
Welcome to the training manual for the new generation of ShockLog products. This training tool has been split into two separate

manuals and has been designed to provide useful information to all levels of users from complete beginners’ right through to

regular users of the ShockLog products.

This specific manual has been written to be generic for the full range of ShockLog although many of the pictures will include

references to 298, they are equally applicable to the 248 and 208 ranges.

Product Introduction
The next generation of ShockLog products has been completely redesigned from the ground up, building on the vast knowledge

gained from the 12 years that the previous generation has been out in the market. This new generation will replace both the

current RD298 and the RD317 Micro ranges of ShockLog’s and, in addition, add a new lower specification range.

To ensure a seamless transition for all of our customers we have made all of the new generation of ShockLog products and all

new software fully backward compatible to the previous generation, including the mounting hole sizes and template.

For comparison purposes the new 298 range is the direct replacement of the old RD298 range and the new 248 range is the

replacement of the old RD317 micro range. With the 208 range being a new addition to the family with reduced functionality and

cost bring the benefits of the ShockLog products to a larger potential user base. 

Declaration of Conformity 
Hereby, Lamerholm Electronics Ltd declares that this ShockLog product is in compliance with the essential requirements and

other relevant provisions of directives, ESTI EN 301 489, EN 61326, FCC Rules CFR47 Parts 15 and RTCA/DO160D. Copies of all of

these Declarations of Conformity can be found on the enclosed Software CD and at

www.lamerholm.com/declaration_of_conformity

298 Range
Forming the replacement to the legendary RD298 ShockLog range the enhanced 298

ShockLog combines Lamerholm Electronics advanced tri-axel piezo electric accelerometer

technology with the latest electronic technology and software to offer advanced shock

and vibration monitoring instrumentation.

The 298 has been designed to monitor shock and vibration based on acceleration or

velocity measurements. The device has several unique features, which make it suitable

for applications where the cost of exposure to out of specification environmental

influences is very high. The instrument is equally suitable for protecting high value fixed

or mobile installations and investigating shock and vibration during transportation.

The comprehensive Windows based software program allows you to program your own wake up, warning and alarm levels and

frequency of data collection as well as the setting of the Acceleration or Velocity range and Frequency filter. When a programmed

impact level is exceeded a visual alarm will alert you as well as storing the data for future analysis.

Features:
− Built in temperature sensor with optional humidity sensors

− Completely self contained (battery operated)

− Velocity or acceleration measurements

− Adjustable Warning and alarm thresholds

− User selected frequency cut off

− Low cost standard AA size lithium or alkaline

− USB and iButton communication interface

− Lamerholm ‘BUS’ communication facility

− Optional Zig Bee RF module for communication

− LED operation, warning and alarm status indicators

− Date and time stamping

− RF screened and CE certified 

− Greater than 18 month battery life

− Complete journey profile

− Detailed record significant events (up to 870 events)

− Optional external sensors

− Tamper-proof factory and user passwords

− Data stored in non volatile memory
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248 Range
Being the replacement to the current RD317 Micro ShockLog range the enhanced 248 ShockLog

combines Lamerholm Electronics advanced tri-axel piezo electric accelerometer technology with the

latest electronic technology and software to offer advanced shock monitoring instrumentation.

The 248 has been designed to monitor shock based on acceleration measurements. The device has

several unique features, which make it suitable for applications where the cost of exposure to out of

specification environmental influences is very high. The instrument is equally suitable for protecting

high value fixed or mobile installations and investigating shock during transportation.

The comprehensive Windows based software program allows you to program your own wake up

and alarm levels and frequency of data collection. When a programmed impact level is exceeded a visual alarm will alert you as

well as storing the data for future analysis.

Features:
− Built in temperature sensor with optional humidity sensors

− Three built in accelerometers

− Completely self contained (battery operated)

− Acceleration measurements

− Adjustable alarm thresholds

− Low cost standard AA size lithium or alkaline

− USB and iButton communication interface

− LED operation and alarm status indicators

− Date and time stamping

− RF screened and CE certified

− Up to 12 month battery life

− Complete journey profile

− Detailed record significant events (1st plus 14 most significant)

− Tamper-proof factory and user passwords

− Data stored in non volatile memory

208 Range
The 208 ShockLog introduces a whole new series of ShockLog products to the range and is aimed at

the entry level market. The units utilise Lamerholm Electronics advanced tri-axel piezo electric

accelerometer technology with sophisticated electronics and software offering an advanced shock

monitoring instrument however the 208 series is restricted to recording time slot data only.

The 208 has been designed to monitor shock based on acceleration measurements. The device has

several unique features, which make it suitable for applications where the cost of exposure to out of

specification environmental influences is very high. The instrument is equally suitable for protecting

high value fixed or mobile installations and investigating shock during transportation.

The comprehensive Windows based software program allows you to program your 208 for frequency of data collection and the

sensor data to be captured.

Features:
− Built in temperature sensor with optional humidity sensors

− Three built in accelerometers

− Completely self contained (battery operated)

− Acceleration measurements

− Low cost standard AA size lithium or alkaline

− LED operation and alarm status indicators

− Date and time stamping

− RF screened and CE certified battery

− Up to 12 month battery life

− Complete journey profile

− Tamper-proof factory and user passwords

− Data stored in non volatile memory

− Low cost units

− Easy to understand journey profile information
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Legacy Products
The ShockLog recorders are small battery powered data loggers fitted with three built-in piezo accelerometers and an internal

temperature sensor. The design has been optimised for the measurement of shock and vibration for investigative and protective

purposes on goods in transit and storage throughout the supply chain.

RD298 ShockLog Recorder
This range of ShockLog products is the original ShockLog and has been in operation since 1998. The

RD298 ShockLog recorder has a high level of flexibility with user selectable ranges and thresholds. It

can be used to analyse the environmental conditions encountered throughout a journey or storage

period with a high level of detail.

This product is available with the standard frequency filter or a number of special frequency filters

developed for use on larger metallic shipments.

Additionally the RD298 range allowed for a number of accessories to be added to increase the

environmental conditions that could be recorded

RD317 Micro ShockLog Recorder
This range of ShockLog recorders was introduced in 2000 and was designed to provide a high level of accuracy and data capture

ability at a lower entry level price band. The units are smaller in physical dimension and have a reduced functionality over their

big brother the RD298.

With the RD317 Micro ShockLog range, the shock recording ranges and frequency filters are fixed at the factory with the users

still being allowed to create their own threshold levels.

The RD317 Micro ShockLog range introduced the use of iButton communication technology to the ShockLog brand simplifying

the users interface to units and potentially allowing downloads of journey reports while the unit remained in situ.

Additionally the RD317 Micro ShockLog was restricted to only having a factory fitted option of external temperature and Humidity

and has no aftermarket accessories.

Overview of Accessories
RD299 HPT (Humidity Pressure Temperature) Sensor
The RD299 is a combined humidity, pressure and temperature sensor for use with the 298 ShockLog recorder. It enables any

version of the 298 to monitor an extended range of environmental factors and is fully supported by the ShockLog software.

The RD299 HPT has been designed to meet IP30 and is capable of operating at temperatures between -40 and +85°C. An

extension cable is available as an optional extra for applications where the RD299 must be mounted remotely from the 298

ShockLog recorder.

RD4000 Single Axis Accelerometer 
The RD400 is a single piezo accelerometer that can be attached a 298 ShockLog recorder to create a 4th axis of measurement. The

additional accelerometer will add a 4th axis of information to the event data files that is capable of being setup, by the user, with

thresholds independently to the main internal tri-axial accelerometers. 

The RD400 Accelerometer is attached to the 298 ShockLog recorder via a cable and utilise the power and memory within the ShockLog.

RD401 Remote Monitoring Systems
To enable the 298 ShockLog recorder to be installed in the heart of what a user is trying to monitor while still allowing the user

access to alarm warnings and to communicate with the units the RD401 systems where developed. The Remote Indicator Units

(RUI) are available in two versions. The 401RIU is a simple device that shows when the 298 alarm has been triggered. It also

allows the operator to reset the alarm condition, after the action has been recorded and time stamped. This unit is powered by an

external power supply. For further versatility, Lamerholm offers the RD401A RIU, specifically for applications where there is no

external power supply or uninterruptible status is required. For added peace of mind the RD401A RIU unit is fitted with a series of

LED lights to indicate the current operational and alarm status of the ShockLog unit.

RD404 Tilt & Roll Accelerometer
The RD404 ShockLog Tilt & Roll accelerometer extends the monitoring capabilities of the ShockLog family of products beyond

impact and vibration to include tilt & sway.
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This extended capability completes the ShockLog ability to monitor and measure the entire physical environment during a

journey or storage period, ensuring you see exactly what your goods & equipment have been through. The RD404 Tilt and Roll

accelerometer connects directly into the 298 ShockLog via an RS232 cable. The RD404 is fitted with its own power supply but

utilises the 298’s memory to store all of its captured data.

Sat alongside the 298 ShockLog the RD404 provides users with exceptional monitoring capabilities extending from the standard

impact and vibration to the monitoring of Tilt and Roll. In addition the RD404 can be used in conjunction with the RD299 HPT

sensor, giving users a complete environmental profile of the journey or storage period.

The ShockLog software has been modified to include two additional time slot graphs in order to provide a graphical

representation of the activity recorded by the RD404 Accelerometer. The additional graphs show the Tilt (front to back) and Roll

(left to right) movement of the unit and are represented as degrees of movement. To ensure maximum resolution the data is

recorded in quadrants and displayed in a range of ±90°.

eTrak GPS/GPRS Tracking & Communication Module
eTrak is a GPS & GPRS transportation tracking device that is capable of connecting to any Environmental Data Recorder with a

communication output providing up to 16bits of data (CRC checked), such as the 298 ShockLog reorder.

The e-Trak device incorporates the latest in GPS and quad band GSM technology. The units are powered by a solar panel and

backed up by a battery supply that is capable of providing in excess of 12 months monitoring without day light. Self contained

within a single enclosure the e-Trak module connects to an appropriate EDR via a cable.

Messages are sent via the GPRS network and arrive at the customer’s desk-top in email format, which are then interpreted by the

e-Trak windows based PC software. Where a GPRS network is not available the e-Trak system automatically reverts to SMS,

sending an appropriate message to a network provider who forwards an email to the customer’s desk-top.

Identifying Current Hardware/Software Versions
Please note this manual applies to ShockLog software version 9.0.101 and is to be used in conjunction with all next generation

ShockLog units (298, 248 and 208 ranges). Additional it is compatible with most legacy ShockLog ranges including the RD298

ShockLog with embedded code version 103 or higher and RD317 Micro ShockLog units with embedded code version 103 or

higher. Although other combinations of the software and embedded code versions of a lower number should function in a similar

manner, there may be some differences.

Identifying Software Versions
To find out which version of the ShockLog software is installed on your PC, start the

software, and look under the “Help” menu option at the top of the screen and select

“About”. In this case, the version is V9.0.8.0 release date 2010.

Identifying Hardware Versions
The hardware version of your ShockLog is displayed in the “Communication” dockable

window. The communication information is only updated when a ShockLog is connected to your PC. This one is code version 9. 

Stage 1
Getting Started
The first section of this training manual is intended to introduce new users of the ShockLog systems to the product and software

and to ensure that you are familiar with the instrument and accessories that you have received.

The ShockLog Kit & Software Installation
New users of the ShockLog range will be required to purchase a kit in order to get all of the necessary communication cables and

software licenses to correctly operate their ShockLog.

All ShockLog kits will be housed within a handy rugged plastic carry case that can be used for storing and transportation of your

ShockLog while not in use.
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Removing the carry case from its cardboard outer protective sleeve and opening your kit will display the following items:

1 x 2X8 ShockLog

1 x CD (Containing software and user manual)

1 x Quick Start User Manual

1 x USB Communication Cable

1 x iButton Set (includes; 1 x start, 1 x stop, 1 x download, 1 x setup and 1 x clock buttons)

1 x iButton USB Connection BUS and Cable

1 x Mounting Kit

2 x AA Lithium Batteries

In the unlikely event that you should find any of the above items to be missing when you receive your kit, please immediately

inform your local distributor or representative who will arrange for a replacement to be provided as quickly as possible.

Once you are happy that you have received everything with your kit you will need to get the software loaded onto your PC. Please

note that many I.T. systems are setup to prevent individual users installing software on their own machines or you may have

restricted rights. Therefore it is essential that you consult with your I.T. Department to ensure you have sufficient rights to install

the software. Please note that this ShockLog software has been designed to run on a standard PC under Windows XP, Vista or 7,

all of which require you to have administration rights to install the software.

Within the CD case you will find the software CD and the Quick Start User Manual, which will also have instructions to assist with

the installation of software and getting you up and running with your new ShockLog kit.

Insert the CD into the CD/DVD player on your PC. The setup menu should

automatically run within a few seconds and present you with a license key

entry screen.  

If for any reason the setup program doesn t automatically run then go to the

start menu and in Run, enter V:\shocklogsetup.exe (where V:\ is the CD/DVD

driver on the PC) and open the program from here. A new will window will

appear which will ask for the software license key.

Enter your name, company name and the unique serial code

supplied with the ShockLog CD. Once the appropriate

information and a valid code have been entered, click on OK

and a new window will appear. In the Microsoft Chart

Controls License Screen, click on ‘Accept’. The installation

will continue and the system will then start to copy files

from the CD and will present you with another window

updating the Microssoft Chart Controls and, again, it will be

necessary to click on the next button to continue.

The user is then presented with the Microsoft Software

License terms. These need to be checked and when you are

happy tick the check box next to “I have read and accept the

license terms”, this will then highlight the ‘Next’ button which will need to be pressed to continue.

The system will then finish the installation of the Microsoft Charts software, click ‘Finish’ to continue.

The system will now automatically start the installation of the actual ShockLog

software. At this stage you will be presented with a ShockLog Set up window,

stating that the Set up wizard will install the ShockLog software onto the machine.

Click on the ‘Next’ button to start the installation. You will then be presented with a

new window setting out the end user license agreement required to utilise the

software.
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The user needs to tick the box next to ‘I accept the terms in the License Agreement’.

And click on ‘Next’, to continue.

Next the user will be presented with another ShockLog set up window indicating that

the system is checking for disk space. This should clear automatically, but should it

fail to, just click on the ‘Return’ button and the system will move to the next point.

Users are now provided with the opportunity to change the location of the software

installation, although it is recommended that you utilise the default settings.

To change the directory address it is possible to either over type the information in

the box or to browse for the desired directory by selecting the ‘Change’ button. Once

you have selected your desired directory, click on the ‘Next’ button.

Users are then presented with a window stating that the system is ready to install the

ShockLog Software, click ‘Install’ to continue.



EssentialsTraining

Page: 8

The system will now start the installation of the ShockLog software. At this stage

you will be presented with a number of progress bar windows with various pieces of

information flashing up. This will then be interrupted by a Microsoft software

installation warning stating that the software has not been verified for compatibility

to windows XP. Click on the ‘Continue anyway’ button. You will then be presented

with the same window and again you need to click on the ‘Continue anyway’ button.

Once the system has fully installed, you will be presented with the following

window.

Click on the ‘Finish’ button to complete the installation.

Your software will now have been loaded and the computer should be back at your

desktop view. In order to create a short cut onto your desk top, right hand mouse

click on the “Start” menu and select the ‘Explore’ option.

The ShockLog programs will have been copied into the following directory:

C:\program files\Lamerholm Electronics Ltd\ShockLog 

In here you will see the ShockLog program file. Right hand mouse click on the

ShockLog program icon and select ‘Create Shortcut’. Once you have created the

short cut this can be dragged onto your desk top.

To open the ShockLog software, double click on the short cut icon from your desk

top.

When first attaching your ShockLog unit to the PC you will be asked to install new

USB drivers in order to enable your PC to communicate correctly with the ShockLog

device. Upon connection you will be presented with the following ‘Found New

Hardware Wizard’ window:

It is essential that the user clicks the ‘No, not this time’ button to stop the system

going to the Microsoft website to find the drivers. Then click on the Next button and

a second found new hardware wizard window will be presented.

Select the ‘Install the software automatically (Recommended)’ button and then click

on the Next button. You will then see a window with a Microsoft software

installation warning stating that the software has not been verified for compatibility

to windows XP. Click on the ‘Continue anyway’ button.

This should now load the appropriate drivers onto your PC to allow the ShockLog

device communicates with your ShockLog Software.

If for any reason the drivers do not load correctly it may be necessary to come back

to this window and select ‘Install from a list or specific location (Advanced)’ and then

browse you PC to find the appropriate drivers within your ShockLog directory.

Note: if your ShockLog does not connect up after loading the drivers successfully, please check your communication ports are

correct, which can be found in the Tools menu under Communication Properties.

Batteries
The ShockLog requires AA size batteries installed and are capable of operating from both 1.5V Alkaline and 3.6V Lithium cells.

(Please note it is not possible to run with a mixture of Alkaline and Lithium). 298 ShockLog units require 2 batteries while the 248

& 208 both require one.
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You will find 2 x AA size Lithium batteries are supplied with a kit and we highly recommend that wherever possible Lithium

batteries are used as they will provide the user with a greater service life across a much wider temperature range. The use of

Alkaline batteries is only recommended for use on very Short Journey/experiments where the ambient temperature is fairly

constant.

Hints and Tips
• Always use Lithium batteries for Journeys where the temperature may vary greater than -5 and +50�C
• The capacity of an alkaline battery drops dramatically when exposed to temperatures below 10�C
• The ShockLog uses 100 times more power when awake compared to when it is asleep!
• If using a lithium battery and your ShockLog will be going by air make sure it is a battery approved for air cargo.
• If you accidentally fit the battery the wrong way around, the ShockLog will not be damaged; however the life of
the battery may have been severally affected.

Fitting the Batteries
• The battery compartment is located on the underside of the

ShockLog unit.(Picture shows 298 variant)

• Remove the four securing screws and lift the battery cover clear.

• Ensure the orientation of the batteries is correct and insert both

batteries into the ShockLog unit.

• Ensure the rubber seal is correctly positioned, replace the battery

cover and insert the 4 screws. Care should be taken when screwing

down the lid ensuring they are tightened evenly in a diagonal

rotation and tightened to 25cNm Torque. 

Opening the Software & Initial Layout setup
Now that you have installed the software and got your ShockLog unit

operational, the next stage is to open up the ShockLog software and to set the

“Dockable” tables into the desired location.

The software can either be opened by double clicking the shortcut icon or

selecting the program from the start menu.

When the software first opens you will be presented with a blank “File Viewer”

screen and in the top left hand corner you will see that there are three

“Dockable” windows that need to be positioned.

You can pick each Dockable window up by clicking and holding the left hand

mouse button. You can then drag the window around and you notice that little

window icons will appear at the left, right, top and bottom of the screen and as

you move the window nearer to one of these icons it will highlight in green

where the window will sit.

All of the Dockable windows will work in any of the positions, however the

Explorer View generally works better in either of the left/right vertical positions

where as the Record and Event tables are better suited to the top/bottom

horizontal positions. 

If you want to Dock more than one window in the same position this is possible

and the software will offer you an additional icon showing a series of tabs.
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The position of these docked windows can be saved so you can restore the

saved set if required.  This is done via the Tools menu located at the top of the

screen by selecting the ‘Save Current Settings’ option. Once this has been done

a confirmation window will then appear.

To restored the saved settings simply click on the ‘Restore Saved Settings’

option in the Tools menu.

By dropping the Window on this icon you will create a series of windows that

you can change between via the tabs.

Alternatively, you will

notice when trying to dock

in the same position as

another window you are

offered icons either left

and right of top and

bottom of the current

window.

If you select one of these

options it will leave both

windows displayed side by side. Please note that this is only

possible for a maximum of 2 windows in any one position and

if you try to insert additional windows you will only be able to

utilise the tab system.

Once you have all of the Dockable windows in the correct position you are able

to adjust the size of each window area by dragging the border of each window

area, in order to maximise the available screen area for the “File Viewer”. It

should be noted that you can move and adjust these windows at any time.

You will notice in the explorer and Record view that there are already a number of files in your database. These have been

inserted with the software to provide you with some useable data to get you started and can be deleted if required. If you click on

one of the available files you will see the summary report display within the file viewer.

Now that you have a file open you are able to explore the information available to you from the “File Viewer” screen.

You will notice that there are four tabs along the top of the viewer that will take you to more detailed information relating to the

file record you have opened covering:

• Report

• Slots

• Summary

• Events

We will be looking at all of these areas in more detail later in the manual and again in the Stage 2 manual, but it is a good idea at

this stage just to explore the different views and data available to you.

Desk Top Test
Now that you have the software setup how you want it, let’s enter a basic setup into your ShockLog and run a few Desk Top

Drops so that you are able to View your own downloaded data.

Connecting the ShockLog to your PC
On all ShockLog units the USB communication port is secured behind a threaded protective cap

that also acts as an IP67 seal for the USB Communication Port. To access the USB Communication

Port carefully unscrew the protective cap to expose the USB Connector.

Plug in the USB cable supplied into the ShockLog and then connect the other end to your PC USB

Port.
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Communications Window
In order to be able to communicate with the ShockLog units and to

monitor their current status it is necessary to open an additional

Dockable window called “communications”.

From the ‘View’ menu at the top of the screen, select

“Communications”. 

You will then get a new “Communications” window appear on the top

left hand side of the screen which can be positioned as previously

described.

You should now be able to view the current status of your new ShockLog in the various fields of the communication window.

Send Default Setup
To get your ShockLog operating we need to send it a setup and to simplify this process we have

installed a “default” setup with the ShockLog software. Therefore, from the Communications window

click on the “send setup” button and you will be presented with a file selection window. The system will

automatically take you to the appropriate directory and you will see a file called default.setup413.

Select the default file and click “open”.

A new window will now appear asking “set the ShockLog unit’s clock to the current PC data and time?”

select Yes.

The information bar at the bottom of the screen will come up with a connecting status and then change to OK and a confirmation

window will appear once the setup has been successfully sent to the attached ShockLog unit.

When you click on the OK button, you will notice that the

communication window grey’s out and after a few seconds comes back

but with only a number of the boxes completed. At this stage the

ShockLog unit is clearing its memory and resetting itself ready for the

new recording period.

This process can take several seconds (even minutes depending on the size of the data it is clearing) to complete, but once

completed the ‘Status’ field will come back saying ‘Running’ and you are then ready to disconnect the ShockLog from your PC

and commence the drop test.

Drop Test
Your Shocklog is now recording and you will notice that the green Event Alarm LED is flashing every 5 seconds indicating it is

recording.

Now we need to create a few events by dropping the unit on the desk. Ideally if you have a mouse mat drop the ShockLog onto it,

alternatively a magazine or note pad will suffice to help dampen the impact. It should only be necessary to drop the ShockLog

from approximately 25mm (1” inch) to create an 8 to 10 g shock event.

Repeat this process a number of times and try to get the unit to land on different faces to induce the shock through different axis.

Download the Data
Now that you have run your ShockLog

for a Short period of time and hopefully generated a number of events. If you reconnect your

ShockLog to your PC via the USB cable and either re-open or go back to the communication window

you will be able to view the status of your ShockLog and see that a number of events have been

recorded.

Once you have gathered some event data you need to download the file to look at the data.

Click on the “Download” button on the communication window and you will be presented with an

option to enter comment on the Journey/Data that has been recorded, for an example just enter

“DESK TOP TEST”, then click “O.K.”.
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The status bar at the bottom of the screen will change through

“connecting”, “data transfer” to finally being presented with a separate

alert window indicating that the file download has been completed.

Shortly after the OK status, the new file will appear in your Explorer

and Records Table windows.

View File
Your first ShockLog data file is now ready to be viewed and

the file can either be viewed by clicking on the file within the

explorer window or double clicking the file within the Record

Table.

Within the file viewer you will then be presented with Report

data from your file.

You are now able to explore your new data file and can select

the various screen options of Report, Slots, Summary and

Events, all of which will be covered in more detail in the next

section.

Overview of Software Screens
Explorer View (Dockable Windows)
The Explorer window provides a list of all available data files within the

main database, when you click on any of the files you will see the

report data will be visible on the main file viewer section of the screen

and the file data displayed within the Explorer window will breakdown

into more detail showing Events, Summaries and Slots.

By clicking on the events the system will drill further, displaying all of

the individual events and by ticking any of the events your file viewer

will jump straight to that event and display the detailed event curve.

Record Table
For users that have experience of the old ShockLog software this view

will be familiar to you as the old “Examine Data” screen display.

This screen view provides an alternative view of the data files within the

database and provides the user with an overview of the number of Events, Warnings, Alarms, Summaries and Slots.

Additionally, this screen view provides users with the ability to re-sort the database by the columns of data and we will look into

this in more detail in the Stage 2 training manual.

Event Table
When you have selected a data file with Events in, the Event Table will

refresh to display details of all the events associated with the

highlighted data file and will display the following information: Event

No. Event Data, Duration (measured in seconds), Rate (No. of samples

recorded per second), Temperature, Max X,Y,Z (highest g Force Value

seen in each axis during the event) and the Modulus value of the event.
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By double clicking on the Event number the file viewer will change to

display the detailed Event Curve for the selected Event.

Additionally, it is possible to jump straight from the Event Table to the

relevant section of the Slot graphs by clicking the button under Show

Slots next to the desired event.

Communications Table
As you will have seen while working through your desk top test, the

communications table displays live data from a connected ShockLog

and provides buttons to allow you to perform tasks while you are connected to a ShockLog.

The displayed information from an attached ShockLog unit will be: Model (type of ShockLog Connected), Serial Number (please

note this will not be available on many of the Legacy devices), Version (this is the firmware version of the unit), State (running or

stopped), connection (USB or Serial), Date/Time (as per the units clock), Range (g force range set in the unit), 3 memory status

buttons (informs you when your memory is nearing full or is full), Events (No. of recorded alarms and warnings so far) and finally

Protocol (communication Protocol being used by the attached unit).

The buttons will allow you to perform the following functions:

Download – Creates a download file from the ShockLog.

Start – Where a ShockLog is in a stopped state, this will re-start the unit.

Send setup – Allows you to send a new setup to a unit.

Set Clock – Allows you to re-set the clock to match your PC.

Stop – Where a ShockLog is in a running state, this will stop the unit.

Read setup – Provides the user with the ability to read the setup data and save as a

separate setup file for future use.

Note: In the unlikely event you return to the communication window, while your ShockLog has been connected and the ShockLog

information is not updating, disconnect and then reconnect the ShockLog device to re-activate the window.

In addition to the above buttons you will notice two others that are grayed, and for specialist functions these two options (setup

passwords and security log) will be explained in detail later.

Slot Breaks
The Slot Breaks table presents the user with a list of breaks in the Time

Slot data. These breaks can include all communication with an iButton, the

first slot record or they could relate to alarm resets from an RD401 system.

The table will present the list in a time and date ordered list showing what

the slot break relates to and what slot number the break occurred in.

To view the slot breaks on the time slot graphs it is possible to double click on any of the slot breaks within the table and jump

straight to the appropriate time slot period on the graph.

On the Time Slot graphs themselves the slot breaks are represented by a grey vertical line. By clicking the cursor onto one of

these grey lines the text box on the right hand side of the graph will appear saying what the slot break relates to and on what slot

number it occurred. It is possible for more than one slot break to have occurred within a single time slot period. If this is the case

the text field will list all of the slot breaks in the order that they occurred. (Please see the example on the next page).

File Viewer
The file viewer window is the main section of the window and displays all of the information in relation to a selected file. If this

window gets closed it can be re-opened via the Windows Menu, under ‘New Window’ and selecting the Data view.
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Report
When you first select a file you will be presented with the “Report

View” which for any users familiar with the old ShockLog software

will recognise it as the old one page report. The report provides an

overview of the whole file (Journey/Storage Period/Experiment, etc.)

giving detailed text information as well as graphical presentation of

what has happened.

The text data is broken down into 2 separate tables providing the

following data:

1. Data file summary – Showing the type of unit

used, journey start and stop dates, date the file

was downloaded, recorded duration, the serial

number of the unit and the report start and end

dates.

2. Summary of Events –

Provides details of First

Warning and Alarm

(Includes, Event No., Axis,

Date/Time, Modulus (g) and

temperature at time of event), the table then shows the same details for the most severe event.

Within the Setup Tab a separate table provides a summary of the setup within the unit for the data file and shows

the event, summary and slot settings 

In addition to the text data the report provides 3 separate graphs of the data.

1. Slot Graphs – As standard you will be

presented with 4 graphs showing X, Y, Z axis

shocks and the internal temperature channel.

Users are then able to select different data

channels as required (we will cover this later in

stage 2)

2. Event Summary Graph – Displayed in a bar chart format

this shows the modulus value of all events recorded

highlighting the most severe in Red.
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3. Detailed Event Graph – Displays the detailed event

curve of an event. It will display the most severe event

when you first enter the report and you are able to

display different events by clicking to them from the

Event Summary Graph.

Creating Setup File
Select Model or File
To create or modify a set up file you need to go to the “View” menu at

the top of the screen and select “Set up” and a new window will appear

giving you a list of the currently available ShockLog ranges.

From this window you have the option to either select the ShockLog

range that you would like to create a setup file for, or alternatively you

are able to open an existing file that has been created in the past for

modification.

The ShockLog model that you select will affect the options that will be

available to you as you work through the setup screens with certain features being restricted on the lower model ranges.

For future reference, to open an existing file, you need firstly to select the ShockLog model that you are interested in then click on

the “Load File” button and you will be given a list of available setup files that relate to your selected model to choose from.

Highlight the desired file and click on “open”.

Setup
Once you have selected the appropriate ShockLog model range or opened

the desired setup file, you will be presented with a new window, in this

case “Setup – 298”:

The setup window has a series of tabs that will step you through all of the

options available within the selected ShockLog model and will require

you to fill in the appropriate areas. On a new setup, the system will adopt

the Default settings and therefore pre-complete some sections that can

then be modified, additionally for new setups it will be necessary for the user to step through every window with the “Continue”

button ensuring all options are reviewed.

Options
The first tab is called “Options” and it is looking to see what factory or peripheral accessories you are looking to use with the

ShockLog unit you have selected. You will notice that some options are grayed out or grayed out and ticked, this is where options

are either not available or they are selected by default and cannot be de-selected.

Factory Options:

Local Humidity – Relates to the Legacy RD317 Micro where they have the factory optional Temperature and Humidity sensor

added.

Local Environment – Relates to the new 298, 248 and 208 ranges with the factory optional Temperature and Humidity sensor

added.

GRMS – Users have the option to record the GRMS values within the time slot graphs, allowing users to see the vibration levels

throughout a given time slot period.

HPT Slot Alarms – Allows users to create threshold alarms on Humidity, Temperature and Pressure information received when a

RD299 HPT sensor is attached.

Auto Threshold – Indicates the user would like the unit to function in Auto threshold mode and allows for modification of the

reset times.

DC Accelerometers – This has been included for a future enhancement.

ZigBee Module – Relates to the new 298 and 248 ranges with the factory optional ZigBee radio module being added. 

Peripherals

These relate to the Accessories outlined in the introduction to this manual.
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Click in the tick boxes of all the options that you are expecting to utilise with your ShockLog and then click on the “Continue”

button.

Settings
The settings window allows the user to select the

‘g’ range, frequency filter, Protocol, iButton

password, create setup name, enter mission

comment and set start date.

To set the range click on the drop down menu to

view all the possible ranges (1, 3, 10, 30, 100 &

200). The 298 will also record in velocity; this will

automatically occur if you select a range in cm/s.

Generally most users are interested in g.

Tip:
• Selecting the range is a very important part of your set up. You need to be aware of what impact levels you are really interested
in. Do not assume that if you set the ShockLog to the 100g range you will just get everything. Firstly the resolution will be
compromised, and secondly you may not get low level events being recorded at all. The wake up threshold for a detailed event
must be at least 5% of range (and recommended to be no less than 10%), therefore, you will not record events lower than 10g
with a 10% wake up threshold on a 100g range.

• It is impossible to make exact recommendations as to what range a particular shipment should be monitored with, but as a rule
of thumb the larger and heavier the object the less g it generally takes to damage due to the amount of mass. Therefore the 10g
range is generally used for large objects (E.g. something weighing tonnes!). The 30g, 100g and 200g ranges being used for
smaller shipments.

Next you are able to select the frequency cut off Hardware Filters to be applied to your event data. These filters enable users to

reduce the number of unwanted higher frequency events, where it is known that this type of event will not cause damage to the

object being monitored.

The lower the filter the more severe it is with regards to eliminating events. The lower frequency filters are

generally used for large heavy objects with a high metallic content, especially where they are prone to high

levels of resonance. These resonances will create a bell like ring that a ShockLog can pick up as a high g event if

the appropriate filters are not applied. Filters are additionally recommended in environments where a high

frequency vibration is probable, such as rail freight applications, and again the correct use of filters can

eliminate any unwanted events being recorded. 

The Protocol settings are for future development of the ShockLog products and at the moment are only available as the “Protocol 400”.

iButton Password allows users to create password protection within the iButton system to prevent unauthorised users interfering

with the ShockLog through the iButton interface. To create password protection on the iButton interface, users are able to

program the ShockLog with their own password (up to 8 characters in length and case sensitive). Then any iButton wishing to

communicate with the ShockLog will also have to have been programmed with the same password otherwise the ShockLog will

simply ignore the iButton being attached.

The Password is created by clicking in the Password box and typing in the password. The password then needs to be confirmed

by re-typing within the confirm box exactly the same as the password box. 

Setup Name allows users to name their setup and therefore save as a unique file for future use. On a new set up the word Default

will be in this field and the user will be required to change this before they are able to save the setup, send it to a ShockLog unit

or move onto the next stage of the setup process.

Tips
• If you have a ShockLog connected to the PC and you want to know what setup it contains click ‘Read Setup’ on the
Communication Window.
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A Mission Comment can be added to the setup program. Any notes added here will be recorded

within the ShockLog and will display on the Report screen of a downloaded file along with all of the

other setup information.

The last area to be setup on this screen is the Start Date and time. If you would like your ShockLog

unit to remain in a sleep mode until a future date/time you can click on the right hand arrow to bring

up a calendar selector and select the desired date. Additionally if you want the unit to start on a

specific time you are also able to over write the start time as required.

Tips:
• Use this feature when your the ShockLog is being set up away from the shipment it will ultimately be attached to.

• If you have set a start date, but change your mind and want the recording to start earlier, clicking ‘start’ on the communications
screen will override the delayed start, the ShockLog will begin recording immediately.

Slots/Summary
Slot Contents, used to select the parameters to be recorded for the Time

Slot graphs. These are the bar graph view of the journey you looked at

earlier. Firstly select the parameters you would like to log as time slots by

clicking the appropriate boxes. The normal settings are to log the max peaks

on x, y, z and the internal temperature.

Tip:
• The more parameters you select the less run time the time slots will last
for, so only set the unit to record what you are interested in!

Once you have selected the parameters to be recorded you need to select the frequency of the recordings.

Using the Slot Interval users are able to select a time interval for how often a slot will be recorded. The

window below will show how long the time slot graph will run for according to your settings.

Tip:
• Battery life is not affected by time slot frequency, so it is advisable to always select a time slot interval that
will last a bit longer than your proposed journey length plus a bit of insurance time.

The summaries are a summary of what happened to the ShockLog in the last period of time since the last

summary was recorded. The summary records the number of warnings/alarms, max & min impacts in x, y

and z, max and min temperatures and the range the ShockLog was set on.

All you can do with this feature is to set the time period between each summary period and this is done in the Summary Interval
section.

Tip:
• As with time slots the battery life is not affected by summary intervals, so it is advisable to always select a summary interval that
will last a bit longer than your proposed journey length plus a bit of insurance time.

Events
The information in the Events tab sets how a detailed event will be

recorded. These settings will dictate how long the detailed event will be

and how many events you can log in a journey.

Tip:
• Generally you are looking to log detailed events when damage may have
occurred to your product. As with the range, going for settings that allow
for the maximum amount of events is not always advisable. You have got to
ask yourself – is it useful to have 500 detailed events?

• Don’t forget you get a time slot graph for the whole journey!
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The Record section allows users to specify the resolution / memory to be allocated to each event and therefore how many events

could be recorded. From the “Length” option, the more bytes you allocate to an event the more points the event graph will

display. The ShockLog always logs at 4096 samples per second, but according to your event settings the ShockLog will compress

the data when saving according to how long the event is.

The peak of an event will not be lost when data is compressed as the ShockLog will always keep the max & min samples of each

compressed data section.

Next you must select a “max time”, which will be the maximum length of any recorded event (note, all events must be a

minimum of 1 second). Select the max time according to how long any individual event will be allowed to be. Note the longer the

event the more the data will be compressed.

In certain situations, generally while in a test environment, it may be applicable to want the ShockLog to always record the full

length of an event, potentially up to 128 seconds, if this is the case then the “Always Max” box will need to be ticked.

New to this generation of ShockLog products, it is now possible to record events in an uncompressed format displaying the full

4096 points per second. If this level of detail is required then the “Ordered Data” needs to be checked.

Tip:
• Unless you have a specific reason to do so, do not use the always max, let the ShockLog decide when the event has finished by
the drop out threshold (covered later).

The Thresholds section of the Event tab are the settings that determine

when your ShockLog wakes up, the levels at which a warning or alarm is

created and the drop out level of the event. A simple bar chart can best

explain these thresholds.

1. If any accelerometer activity exceeds the wake up

threshold the ShockLog will wake up and start recording (The

ShockLog takes 1mS to wake up and start recording). If the

activity doesn’t exceed the warning level, as in this case, the

ShockLog will go back to sleep once the activity drops back

below the dropout threshold level and not log an event.

2. Once the wake up threshold and the warning level has

been breached the ShockLog will now record a detailed event

and in this case flag it as a warning.

3. Once the event activity has dropped below the drop out

threshold (or reached the event maximum allowed event

length). The ShockLog will stop recording and go back to

sleep.

Within the “Options” drop down menu you are able to select one of three modes for the thresholds to work in. The standard

mode is “Link XYZ, where all of the axis will operate off of the same thresholds. Alternatively users are able to select “Multiple”,

which will allow users to select different thresholds for different axis depending upon the sensitivity / fragility of an object being

monitored, and lastly, there is an option with the new ShockLog range to set the Events up on a timed basis, whereby a detailed

event will be recorded at the end of every summary period and will not be dependent upon thresholds being breached.

“Wake threshold” - As stated in the battery life section, the ShockLog uses 100 times more power when it is awake compared to

when it’s asleep. For example, you do not want the ShockLog to be continuously awake due to the low level vibration of the

mode of transport that your product is being shipped in. The ShockLog will easily see 0.5 to 1g of activity when being transported

in a car on normal roads.

Tip:
• It is not advisable to use a wake up or drop out thresholds of less than 10%, although levels can be set down to 5%

“Warn and alarm” - Events are recorded in exactly the same way, except the thresholds distinguish how they are flagged in the

ShockLog data file, and how the LED’s on the ShockLog unit flash once a threshold has been breached.
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Tip:
• Warning and alarm thresholds become more important when the ShockLog LED’s are to be used as part of an initial audit upon
receiving a shipment. For example, set a warning level to indicate you want the shipment to be quarantined pending further
investigation. Set the alarm threshold to be at a level where the shipment must be investigated without delay.

“Drop Out” – This is the level at which the ShockLog will stop recording an event provided it has exceeded 1 second and the

“Always Max” box has not be ticked.

Alarm A
You have now specified the time slot, summary and event criteria for your

setup and the next two tabs allow you to specify special Alarm settings

depending upon the factory options and peripherals that you specified back

in the options tab.

“Acceleration” – This is only applicable for the 208 ShockLog range, where

the units do not have the capability of recording detailed event curves but are

capable of triggering an Alarm if a shock within a Time slot period exceeds

these thresholds.

“Environment” – This area allows users to set up various low and high thresholds for Temperature, Humidity, Dew Point and

Pressure depending upon the sensors fitted to the ShockLog. The same section is used whether the sensor is locally fitted or

externally fitted.

Alarm B
The second Alarms table is for use when a Tilt and Roll accelerometer has been

attached to the 298 ShockLog. The table is set up with both upper and lower

limits of Tilt and Roll and can be assigned to either the internal accelerometers

or the external accelerometers.

Note: The Internal options have been included for future development of the

ShockLog range and at the moment it is only possible to obtain an external Tilt

and Roll accelerometer.

Finish
You have now created a setup file that can be saved and sent to your

ShockLog. The “Finish” tab provides a summary of the settings you’ve made

and provides a chance to save the file and send it to a ShockLog device, which

we will now work through in the following sections.

Saving Setup File
Once a setup has been defined it must be saved before it can be sent to a ShockLog. You should have already

defined a unique name in the setup file box under settings and all you need to do now is click disk save icon.

The system will automatically save the file away in the default setup directory and can be retrieved for editing

or sending to a ShockLog at anytime.

Sending Setup to ShockLog
Now that you have created the setup and saved it you are ready to send the file into the attached ShockLog.

Once the ShockLog is connected, click on the Play icon, the status bar at the bottom of the screen will then

change to OK once the file has been successfully sent.
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Monitoring & Downloading a ShockLog
Communication Window
Details of opening and docking the communication window

are described earlier in this manual within the “getting started” section and this section continues from there assuming the user

has opened the communication window.

Overview of information displayed
With the “communications” window open and a ShockLog attached to your PC the information boxes will automatically update

with information live from the ShockLog and the following is a description of the information displayed:

Model – Will display the model variant of the ShockLog attached i.e. 298, 248 or 208.

Serial Number – This displays the serial number of the ShockLog unit attached. It should be noted that this box will not work with

some legacy products.

Version – This is the firmware code version within the ShockLog unit.

Events – This displays the number of events seen during this period of recording. For a 298 ShockLog this will display both

warning and alarm events separately, on the 248 it will be the number of recorded alarms and for a 208 unit it will display the

number of slot events seen.

Memory Status – This is displayed as three separate colour dots, Slot Mem, Sum Mem and Event Mem and identifies the status

of each section of memory with green being OK for memory, orange being 90% full and red meaning memory full.

Connection – Identifies the type of connection currently being utilised to communicate with the ShockLog unit and will display

USB, Serial or ZigBee.

Date/Time – This is being read from the ShockLog unit and will continue to update every 10 seconds while the unit is

communicating.

Range – Shows the shock g range that has either been factory set, as per 248 or 208, or user set as per the 298 variant. 

State – Displays the operating state of the ShockLog being either 'Running' or 'Stopped'.

Slot Alarms – This will display the number of slot alarms, if set-up, that have been recorded. 

Protocol – Displays the communication protocol currently adopted by the connected ShockLog device. The new generation will all

display P400 and Legacy units will display SL.

Overview of Buttons
On the Communication window there are eight buttons available to communicate with the ShockLog devices. The first six are

immediately available upon opening the communications window with the final two requiring activation by the users.

With regards to the six standard buttons they can be used to perform the following functions:

Download - This will activate the download process described in the Drop test procedure earlier in this manual.

Start - This will start a ShockLog unit running that has been left in stopped condition.

Send Setup - Allows a user to select a setup file and send it to the attached ShockLog. It is essential to ensure that all data within

the ShockLog has been downloaded before sending a new setup as this process will clear the memory and the data is not

recoverable.

Set Clock - This will synchronise the ShockLog clock with the users PC.

Stop - This is used to stop a ShockLog recording, for example if a journey has been completed and the ShockLog is to be

removed before download, it may be appropriate to stop the recording before removal.

Read Setup - If you wish to know the setup within an attached ShockLog it is possible to download and save the setup file,

making it readable in the setup option.

The final two buttons can be activated from the view menu at the top of the screen.

Once activated the buttons will enable the users to setup passwords and view

the security log of the attached ShockLog and are described in more detail later

in this manual.
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Download and importing of Legacy Data Files
With this latest version of ShockLog software it is possible to communicate with both the latest generation of ShockLog products

as well as legacy products and this section will cover the process of downloading files from legacy products and for importing

these files into the new database format.

Download
The process is very similar to that of the new generation

products. With your ShockLog attached you will be able to

open the communication window and view the current status

of the ShockLog unit.

Select the download button and enter your user comment as per the new generation products, then click OK.

The status bar at the bottom of the screen will then change through “connecting”, “downloading” and then finally “O.K” once the

download has been completed. As with the new generation of ShockLog products, at this stage the system will automatically

import the download file into the database appearing in the explorer view.

Import of Legacy Data Files
In order to convert the old legacy data files it is necessary to import into the database. Under the file menu select the “Import”

option.

You will now be presented with a file selection window. If you have just

downloaded the data file using the latest software, you will be presented

with the correct directory and it will just be necessary to change the file

type to view the old style data files, you need to select (*_sl_data).

You will now have a list of available data files. Highlight the desired File a

Click “open” and after a few seconds the file will appear at the bottom of

the explorer file list.
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If you are looking to import data files that have already been

downloaded with the old ShockLog software, it will be necessary to

change the data directory to that of the old software ‘data’ directory.

You will then be able to select the required data file and select

open.

If you have a number of data files that you wish to import all

together, this is also possible via the import routine. Follow the

process as described above but instead of just clicking on a single

file, find the first file in the list, click on this file, hold down the shift

key and then click on the last file you want to import, release the

shift key.

You should now have a range of files highlighted and by pressing

the ‘Open’ button they will all now be imported. This can take

several minutes and throughout this the software will appear to be doing nothing until the files start to appear within your

explorer screen.

It is also possible to select a number of specific files using the control key to highlight the required files from within a list. Again

clicking on the ‘open’ button once the desired files have been highlighted will import the files.

iButton Interface
A Download iButton can be used to read a snapshot of

the data stored in a ShockLog. This data will contain the

most significant event and Slot data, both in a

compressed format.

Due to the compressed nature of the data; it can only be

viewed via the Report and Setup tabs; Summary and

detailed Event information are not available.

The iButton interface window is accessed via the ‘View’

Menu and creates a new window. Within the window

users are presented with three tabs, Read, Passwords and

Program.

Read
Read is the first tab presented to users upon opening the iButton

interface and this screen is used to read what is on any attached

iButton unit. The USB connector and BUS connector should be

plugged into the PC USB port and any drivers downloaded, if this is

the first time of using. (Please note the downloading of the drivers

should be automatic, exactly the same as the ShockLog unit itself, and

please ensure that the “No, not this time’ option and the ‘Automatic’

as you work through the screens.

Upon plugging an iButton into the connector BUS the software will

display the type of iButton being read and whether or not there is any

data in the device.

You can see with the example on the right that we have attached an

iButton programmed to work the ‘Download’ function on a ShockLog

unit and that the unit has data it has downloaded from a ShockLog

ready to be transferred to the database.

To download the iButton data, the user needs to click on the

‘Download’ button leaving the iButton firmly in the connection BUS.

If the user is using an iButton originally set up for use with the legacy
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RD317 products a warning will appear stating that the iButton is for an RD317

and asking if you wish to change to RD317 mode. By ticking the yes button,

the RD317 mode tick box will be completed and any programming of the

iButton will be created in the RD317 compatibility mode. 

If you are setting up a new iButton and wish to use it with a legacy RD317 unit,

then it is necessary to tick the RD317 Mode box before proceeding to

passwords or Program to ensure the iButton is set up correctly for use with

the older products.

Passwords
With the iButtons and ShockLog units there are two levels of password

protection, the first being the iButton password, which is user definable and the second being the ShockLog password, which are

factory set and cannot be changed by the user.

iButton Passwords – iButton passwords can be used to prevent unauthorised access

and actions being carried out on a ShockLog via the iButton interface. In standard

mode the ShockLog would allow a user to stop the recording with an appropriate

iButton, programmed to stop. By programming the ShockLog with an iButton

password, any iButton being used to communicate with the ShockLog must then be

programmed with the user defined password, otherwise the ShockLog will ignore it.

The iButton passwords must be programmed into the ShockLog unit via the setup

program. The password needs to be less than 8 characters and is set on the ‘Settings’ tab of the ShockLog Setup window.

The password needs to be entered into the password box and then repeated in the confirm box. The passwords are case sensitive

and will accept numeric values; however, it is not possible to enter characters.

When a ShockLog is programmed with an iButton password, all iButtons used in conjunction

with that ShockLog unit must also be programmed with the appropriate password otherwise

the ShockLog unit will just ignore the command. To program an iButton with the appropriate

password, the iButton needs to be connected to the PC via the USB connection BUS and

then the Password tab selected.

Within this tab, click the mouse within the Password box under the iButton section and enter

the password exactly the same as the setup file. Then either using the Tab key or clicking

with the mouse to move to the confirm box, re-enter the password.

Once the passwords have been set, it is necessary to reprogram the iButton so that the

passwords are set. To do these please follow the instructions set out below under ‘Program’.

ShockLog Passwords – The ShockLog Passwords are factory defined and are not changeable by the user. The ShockLog

passwords will work in a similar way to the iButton passwords preventing communication with the ShockLog from iButtons that

don’t have the appropriate passwords programmed in. However, the ShockLog passwords are unique to each ShockLog and are

supplied with the units when purchased, therefore providing a unique number for every ShockLog preventing generic passwords

being set up and used on all units.

Every unit sent out from the factory will have 3 passwords supplied with it, being Level 1, Level 2 and Level 3. The ShockLog

password used here requires the Level 2 password.

In order to activate the passwords in the ShockLog unit itself, the user will need to follow the

instructions set out in “setup Passwords” later in this manual. Once this has been activated

the only iButtons that will be able to communicate with that ShockLog unit will be those

programmed with the same ShockLog level 2 password.

To program an iButton with the appropriate password, place it into the USB connector BUS

attached to your PC and open the iButton interface. Select the Passwords tab and enter the

ShockLog password into the Password box under the ShockLog section. Re-enter the

password in the confirm box and then go to the Program tab and follow the instructions set

out below.
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Program
With an iButton attached to the USB Connection BUS, when entering the ‘Program’ tab, the

user will be presented with two tick boxes for the different passwords available and then 5

buttons with a combination of either grayed out or are live, depending upon the iButton that

is attached.

The buttons allow for the creation of: Start, Stop, Setup, Clock and Download iButtons. A

number of the iButtons utilized by the ShockLog can be programmed for a number of

different options providing the user with more flexibility in their stock of iButtons.

If an iButton is to be set with a password, it is necessary to click on either the iButton or

ShockLog password box at the top of the tab. This will take the user back to the Password

tab, where the passwords need to be entered or created, and this can be achieved by following the ‘Password’ section just before

this in the manual.

Clock iButton
The new Clock iButton only operates with the 208, 248 and 298 ShockLog models. It has no memory in which to store passwords;

so a special scheme operates when using the Clock iButton to set the clock on a ShockLog that is password protected.

1. First stop the ShockLog with a Stop iButton that has been programmed with the relevant passwords.

2. The ShockLog will now provide a 3 minute window, in which the user can use Clock iButton to set the ShockLog clock before it

will become locked out by the units passwords again.

3. Once the clock has been set, the user can use a Start iButton to restart the ShockLog; or use a Setup iButton to send a new

setup to the unit and let unit start automatically, (dependant on the Setup's parameters).

Once the passwords have been set, clicking on the appropriate program button will send the program into the iButton. The

progress bar at the bottom of the window will work its way across the screen and the word finished will appear once the

programming is complete.

If the user is sending a setup to the iButton, upon clicking the setup button, the user will be presented with the file search window

and will be asked to select the desired setup file. Please note that if passwords are required, they will have had to have been

setup within the setup file before sending to the iButton, please see file setup section earlier in this manual.

Setup Passwords
The ShockLog passwords enable users to protect their units from unauthorized

access, download and corruption. The ShockLog passwords are factory defined

for every ShockLog and are unique to each ShockLog serial code.

To set the passwords within a ShockLog it is necessary to firstly activate the “Setup Passwords” key on the communications

window. To do this, go into the View Menu and select the Password Setup Button. When you then go back to the

communications window the Setup Password button will be available to you. 

With the ShockLog that you wish to protect attached to your PC, click on the ‘Setup Password’

button from the communications window and a new window will open asking the user to enter the

Level 2 password for the ShockLog. Enter the 8 digit numeric code, then click in the ‘Enable

Passwords’ box and click on OK.

The Status bar will show that the system is connecting to your ShockLog and then after a number of seconds will come back

stating OK and your ShockLog is now password protected.

Now when ever a user tries to communicate with the ShockLog they will be required to enter an appropriate level password to

gain access and they will be presented with a window requesting them to enter the required level of password.

The following levels are required:

Stop – Level 1

Start – Level 1

Download – Level 2

Send Setup – Level 2

Set Clock – Level 1

Read Setup – Level 2
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It should be noted that your ShockLog program has been set up to memorise a password while you are still in the same session

with the same ShockLog attached, therefore, once a levels password has been entered it will not need to be re-entered until a

new ShockLog session is opened.

To remove the password from a ShockLog unit, re-attach the ShockLog to the PC and open the communication window. Click on

the Setup Password window, enter the level 2 password but this time click on the OK button when the ‘Enable Passwords’ button

has not be ticked. This will remove the password setting from the ShockLog.

Security Log
The ShockLog Security Log provides users with a detailed list of communication

activity with the ShockLog unit. This data will include dates and times of

activities and a description of the activity, providing an additional audit trail for a

data file. The ShockLog Security Log can only be cleared by the factory during

the ShockLog calibration process, for security reasons users are not able to clear

this file.

To view and export the security log within a ShockLog it is necessary to firstly activate the “Security Log” key on the

communications window. To do this, go into the View Menu and select the Security Log Button. When you then go back to the

communications window the Security Log button will be available to you. 

Once this button has been activated

and a ShockLog unit is attached to the

PC, clicking on the button will bring up

the following grid of information:

The Grid provides the following data

columns:

Rec’ No – This is a sequential number

tag given to every activity recorded.

Date & Time – Provides the specific

date and time the activity occurred.

Entry – Provides a description of the

activity recorded.

Data – Shows the size of the data

recorded.

The grid is also sort able as per the

rest of the database columns and by

clicking on the top of any of the

columns, the data will be resorted by

that column. By sorting on the Rec’ No

column, you will always return back to

the original order.

The Security Log data can also be exported into a comma delimited file for

importing into other applications such as Microsoft Excel or Word. To Export, click

on the Export button at the bottom right hand side of the grid, where you will be

presented with a file save window.

Amend the file name as required and select a different directory as required from

the drop down selection at the top of the screen.

Once you are happy with the file name and directory, click on the save button and

the file will automatically save as a CSV file for importing into other applications. 


